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Some of the solutions presented in this booklet use techniques that are not included in the current CAT 

curriculum. They are presented here as alternative methods for solving the problems. It is hoped that teachers 

and participants (learners) will look at the methods used and consider using them in their Practical 

Assessment Tasks which, in a sense, are open-ended and where use can be made of techniques not included 

in the curriculum (see Assessment Criteria 6 and 10 of Phase 2 of the DBE’s 2020 PAT for Grade 12). 

A: WORD-PROCESSING 

Use the document Track and Field.docx to answer the following questions.  

 

A1 The size of the pictures of the athletes has been changed so that they fit 

into the document. What was the original width (in cm) of the picture of 

Wayde van Niekerk? 

6.35 

The pictures of the athletes are all found under the heading ‘Top South African athletes’. Navigate to this 
heading and select the picture of Wayde van Niekerk.  
 
Method 1: Right-click 

Right-click on the picture. On the right-click menu click on ‘Size and Position…’ 
(see Figure 1). 
 
 
 

The ‘Layout’ dialog box 
shows the original size of 
the picture at the bottom 
(see Figure 2). The original 
width is 6.35 cm. 
 
The ‘Reset’ button can be used to change the picture 
back to its original size. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Method 2: Picture Format tab 

Select the picture of Wayde van Niekerk and click on it. The ‘Picture Tools’ 
tab will now appear in the ribbon. Click on the ‘Picture Tools’ tab and then 
click on the arrow at the bottom of the ‘Size’ group (see Figure 3).  
 
This will display the ‘Layout’ dialog box. The answer of 6.35 cm can be found 
as in Method 1 (see Figure 2). 
 

Figure 1 

Figure 2 

Figure 3 
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A2 What is the name of the style used for the cover page of the document? Motion 

Insert Cover Page 

In the ‘Pages’ group of the ‘Insert’ 
tab, click the drop-down control 
next to ‘Cover Page’ (see Figure 4). 
Scroll through the thumbnails until 
you find the closest match to the 
cover page of the document. This is 
the ‘Motion’ style (see Figure 5). 
You will note that the image of a 
train has been replaced with a more 
appropriate image.  
 

 
 
 
 

A3 Six sources are listed in the bibliography. How many of these sources 

are actually cited in the document? 
5 

Manage Sources 

In the ‘Citations & Bibliography’ group on the ‘References’ tab, click ‘Manage 
Sources’ (see Figure 6). 

 
 
 
 
 
The ‘Source Manager’ dialog box will open. Under ‘Current 
List’ there are five sources that are ticked and one which is 
not. A tick indicates that the source has been cited 
somewhere in the document. This means that there are five 
sources which were cited (see Figure 7).  

A4 How many times in the document is there a single letter followed by a 

single digit, e.g. a1 or c3? 
3 

All the methods described below require you to enable Advanced Find. 
This can be done by enabling the ‘Navigation’ pane (‘View’ tab, tick next 
to ‘Navigation Pane’) or by clicking the ‘Find’ drop-down in the ‘Editing’ 
group on the ‘Home’ tab (see Figure 8). The ‘Find and Replace’ dialog box 
will appear with the ‘Find’ tab enabed. 
 
 
 
 
 
Method 1: Advanced Find: Special 

In the ‘Find and Replace’ dialog box click on the ‘More >>’ button to ensure that the ‘Search options’ and 
‘Find’ buttons are visible. 
 

Figure 7 

Figure 6 

Figure 5 

Figure 4 

Figure 8 
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In the ‘Find’ section click on the drop-down next to the ‘Special’ button. In the pop-up menu, 
click on ‘Any Letter (see Figure 9Error! Reference source not found.). The built-in code 
‘^$’ appears in the ‘Find what:’ bar. 
 
Repeat the process described above, except this time click on ‘Any Digit’. The built-in code 
‘^#’ will appear in the ‘Find what:’ bar. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
You can complete the question in one of two ways: 
 

• Click on the drop-down arrow next to the ‘Reading Highlight’ button and 
select ‘Highlight All’ (see Figure 10)   
 
 
 
 
 
 
 
The ‘Find and Replace’ dialog box will display a 
message showing that ‘Word highlighted 3 items’ 
(see Figure 11). 

 
 
 
 
 
 

• In the ‘Find and Replace’ dialog box click the ‘Find Next’ button. Count how many items are found 
until you see a message showing that you have reached the end of the document. You should find 
three items. 

 
Method 2: Built-in codes 

Microsoft Word has a number of built-in codes that can be used for finding (and replacing). You can consult 
the following website to find a complete list of codes: http://editorium.com/archive/searching-with-
microsoft-words-built-in-codes/ . The built-in codes all start with the ‘^’ character (<Shift><6> on the 
keyboard) and are followed by a second character. Most of the built-in codes can be found as described 
in Method 1 but if you know what the codes are you can easily type them directly into the ‘Find what:’ box. 

Figure 11 

Figure 10 

Figure 9 

http://editorium.com/archive/searching-with-microsoft-words-built-in-codes/
http://editorium.com/archive/searching-with-microsoft-words-built-in-codes/
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In the Find and Replace’ dialog box type in 
‘^$^#’ in the ‘Find what:’ box (see Figure 12).  
‘^$’ will search for any letter and ‘^#’ will 
search for any digit. Together they search for 
a digit followed by a letter. 
 
 
 
 
 
 
Proceed as described in Method 1. Three items should be found. 
 
Method 2: Wildcard search 

Wildcard search are a powerful but seldom used way of searching for specific combinations of characters 
in Microsoft Word. For more information the following website provides some useful information and many 
examples: https://www.officetooltips.com/word_2016/tips/using_wildcards.html. 
 
In the ‘Find and Replace’ dialog box, click on the ‘More >>’ 
button to display the advanced search options. Place a tick 
next to ‘Use wildcards’ (see Figure 13) under the heading 
‘Search Options’. 
 
In the ‘Find what’ box type in ‘[a-z][0-9]’. This will search for 
any letter followed by any digit, e.g. a0, b3. 
 
Using either ‘Reading Highlight’ or ‘Find Next’ as in Method 1, 
you will find three items returned by the search (see Figure 14 
below). 

 
 
 
 
 
 
 

  

Figure 12 

Figure 13 

Figure 14 

https://www.officetooltips.com/word_2016/tips/using_wildcards.html
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B: SPREADSHEET 

Each year Athletics South Africa hosts the national championships. The spreadsheet 

CAO 2020 Round 1.xlsx contains the information of some of the individual athletes who registered to 

compete in the championships. Use the information in the Athletes worksheet to answer the questions that 

follow.  

Information about the data stored in each column (fields) is given in the (Field) Descriptions worksheet. You 

should take time to study this information before attempting to answer the questions. 

Before answering any spreadsheet questions, open the spreadsheet and select 

the ‘Athletes’ worksheet. Go to the ‘Data’ tab and click on the ‘Filter’ icon in the 

‘Sort and Filter’ group. This enables filter drop-downs for each column (field) in the 

athletes data. 

When you have used filtering to answer a question, remember to click the ‘Clear’ button to reset the data to 

its original state. 

The data set in the spreadsheet is quite large. When you are working with large data sets it is inefficient and 

time-consuming to drag a formula from the first cell to the last in a range. One of the following methods of 

working is recommended: 

• Use the keyboard shortcut <Ctrl><Shift><Down> to select a long range of data. Click in the top cell 

and apply the shortcut. This will select the whole range. You can also use <Ctrl><Down> and 

<Ctrl><Up> to jump to the bottom or top of a column of data. 

• Inspect the data in the spreadsheet before you start answering questions and note that the last row 

with data is row 1337. You can then easily type in ranges such as E2:E1337 without any dragging. 

B1 What is the surname of the oldest female discus athlete? Kinsley 

Method 1: Filter and sort 

Set filters on the following columns (fields): 

• Gender → Female 

• Event → Discus 
 
Sort the ‘DOB’ column from ‘Oldest to Newest’ (in ascending order). Ascending order is used because 
dates in Excel are stored as a serial number giving the number of days since 1 January 1900. 
 
The surname of the athlete can be seen to be ‘Kinsley’ (see Figure 15 below). 

 
 
 
 
 
 

 

Figure 15 
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Method 2: MINIFS() function 

This function is only available in Office 
2019 or if you have an Office 365 
subscription. 
 
Select any cell in an open column to 
the left of the Athletes data (or work in 
a new worksheet). 
 
 
 
 
 
 
 
Type in the following function: 
 
=MINIFS(E2:E1337,D2:D1337,"Female",H2:H1337,"Discus") 
 
See Figure 16 above for more information about the function arguments.  
The function returns the date serial number 37509 which is the date 2002/09/10, the date of birth of the 
oldest female discus athlete. This date can be used in a number of different ways to determine the surname 
of the athlete. 
 
Method 2.1: Filter 

Use the ‘DOB’ column to filter for the date. Deselect all the dates. Then 
expand the dates for 2002. Proceed as shown in Figure 17. 
 
 
 
 
 
 
 
 
 
Method 2.2: XLOOKUP function 

This is a new Excel function which was only introduced in 2020. You will only be able to use it if you have 
a subscription version of Microsoft Office such as Office 365. 
 
In an empty column to the right of the Athletes’ data type in the following function: 

Figure 16 

Figure 17 
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=XLOOKUP(N2,E2:E1337,B2:B1337) 
 
See figure 18 which shows the arguments 
used in this function. N2 is the cell where the 
date returned by the MINIFS function is 
stored. 
 
Note that the return array is to the left of the 
lookup array which is something which 
cannot be done with a VLOOKUP function. 
 
More information about this function 
including a video can be found by visiting the 
site https://tinyurl.com/tugkax5.  
 
Method 2.3: Index/Match 

For those versions of Microsoft Office which are not able to use the XLOOKUP function, the INDEX and 
MATCH functions achieve the same result. 
 
In an empty cell to the right of the Athlete data type in the following two functions: 
 
=MATCH(N2,E2:E1337,0) 
 
See Figure 19 for details of the function 
arguments. N2 is the cell where the date 
returned by the MINIFS function is stored. 
 
The return value of 91 indicates that the first 
date matching cell N2 is found in the 91st row 
of the lookup array. 
 
 
 
=INDEX(B2:B1337,N6,1) 
 
See Figure 20 for details of the arguments 
used by this function. 
 
The function searches the array of surnames 
for 91st value (returned from the MATCH 
function).  
 
The function returns the Surname ‘Kinsley’. 
 
 
 
The two functions above are often used in a single composite function which is quite difficult to understand. 

  

Figure 18 

Figure 19 

Figure 20 

https://tinyurl.com/tugkax5
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B2 How many junior athletes achieved a time of less than 11 seconds in the 100m race? 15 

Method 1: Filtering 

Filter the ‘Category’ column to display ‘Junior’ athletes. 
Filter the ‘Event’ column to display only ‘100m’ athletes. Add 
a number filter the ‘Achieved’ column to display only times 
less than 11 (see Figures 21 and 22). 
 

 
 
 
 
 
 
 
 
 
 
 
 

15 records are returned (see Figure 23). 
 
 
 
 
Clear the filtering before continuing. 
 
Method 2: COUNTIFS function 

In an empty cell type the following function: 
 
=COUNTIFS(G2:G1337,"Junior",H2:H1337,"100m",J2:J1337,"<11")   
 
The function counts 15 records which match all three criteria. 

B3 How many females born in 2007 took part in the 100m race? 44 

Method 1: Filtering 

Set filters on the following columns (see 
Figure 24): 

• Gender → Female 

• DOB → Year = 2007 

• Event → 100m 
 
 

44 records are found (see Figure 25). 
 
 
 
 

Method 2: COUNTIFS function 

Insert an empty column immediately to the right of the Athlete data (column M). In cell M1 type ‘YOB’ (Year 
of birth). In cell M2 type in the function =Year(E2). This function extracts the year from the Date of Birth in 
cell E2. You might need to format the cell to display no decimal places. AutoFill the function to the end of 
the data. 
 

Figure 21 

Figure 22 

Figure 23 

Figure 24 

Figure 25 
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In an empty cell to the right of the Athlete data enter the following function: 
 
=COUNTIFS(D2:D1337,"Female",M2:M1337,2007,H2:H1337,"100m") 
 

See Figure 26 for details of the arguments 
used for the function. 
 
The function returns a vaue of 44. 
 
 
 
 
 
 
 
 
 
 

Method 3: PivotTable 

Click in any cell in the Athlete data on the ‘Athlete’ worksheet (e.g. cell A2). Go to 
the ‘Insert’ tab and click on ‘Pivot Table’ in the ‘Tables’ group (see Figure 27). 
 
In the ‘Create PivotTable’ dialog box accept all the default settings and click ‘OK’. 
A blank PivotTable will be created in a new worksheet. 
In the PivotTable Fields pane drag the ‘Gender’ field to Rows, the 
‘Event’ field to Columns, the ‘DOB’ field to Filters and the ‘Index’ 
field to ‘Values’ (see Figure 28). 
 

 
 
 
 
 
 
 
 
 
 
 

Figure 29 above shows a section of the PivotTable which is created. 
 
Now apply filters to the PivotTable: 

• Column Labels → 100m 

• Row Labels → Female 
 

Figure 26 

Figure 27 

Figure 28 

Figure 29 
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To apply a filter to ‘DOB’ first click the drop-down arrow next to ‘(All)’. Place a tick 
next to ‘Select Multiple Items’ (see Figure 30). 
 
Then in the Search box type in 2007 and click OK. This will select all the dates 
with the year 2007. 
 
 
 
 
 
The PivotTable now changes 
and shows that 44 athletes meet 
the required criteria (see 
Figure 31). 

 
 
 

B4 How many male athletes in the youth category competed in both the 100m and the 

200m events? 
31 

Method 1: Filtering 

Set filters on the following columns: 
 

• Gender → Male 

• Category → Youth 

• Event → 100m and 200m (both events ticked) 
 
These filters will return 76 records. Some these are shown 
in figure 31. Inspect the records carefully and you will see 
that some names only appear once (athletes who only 
entered one of the two events) and some appear twice 
(athletes who entered both 100m and 200m) (see 
Figure 32). 
 
All those athletes who entered two events have an index which ends in ‘2’ for the their second event. Set a 

text filter on the ‘Index’ column to select records which 
‘Ends With’ 2 (see Figures 33 and 34). 
 
The number of records returned is 31. 
This can be read from the ‘Status Bar’. 
 
 
 
 
 
 

 
Clear the filtering before proceeding to the next question. 
 
Method 2: Deleting records 

Set the same three filters that were used at the beginning of Method 1. Copy the filtered records for the 
‘Index’, ‘Surname’ and ‘First Name’ columns. Paste them on a new worksheet. You should have 77 rows 
with data (1 for the headings and 76 athlete records). Carefully delete those rows where the athlete only 

Figure 32 

Figure 33 

Figure 34 

Figure 30 

Figure 31 
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takes part in one event. Count the number of athlete records that are left (select the 
records and read the record count from the Staus Bar) (see Figure 35). There are 62 
records left. As each athlete has entered two events that must be divided by 2 to given 
the answer of 31 athletes. 
 
You could also use the COUNTA function to count the number of records. 
 

B5 How many male athletes aged 16 years or less are taking part in timed (track) 

events? (Note: Some of the athletes are taking part in more than one timed event.) 
332 

Method 1: Filtering 

Set filters on the following columns: 
 

• Gender → Male 

• Event Type → Track 

• Index → Ends With 1 (to remove athletes entered in more than 1 
track event) 

• Age Group → Deselect 17 (see Figure 36) 
 
332 records will be found. 
 
Clear all filters before proceeding. 
 
Method 2: COUNTIFS function 

The function below can be used instead of filtering: 
 
=COUNTIFS(A2:A1337,"*1",D2:D1337,"Male",F2:F1337,"<17",I2:I1337,"Track")   
 
The function returns the value 332. 
 
Method 3: Remove duplicates 

Set filters on the ‘Gender’, ‘Event Type’ and ‘Age Group’ columns as for Method 1. There should be 435 
records found. Then copy the filtered values from the ‘Index’ column to a new worksheet. In order to find 
the duplicate athletes it is necessary to first extract the athletes number without the final ‘-‘ and number. 
You can do so with a function such as: 
 
=LEFT(F1,6) 
 
Type this function into the top cell next to the copied 
Index numbers. AutoFill the function to the bottom of the 
list (446 rows).  
 
Now select the 6 digit numbers. Now select ‘Remove 
Duplicates’ from the ‘Data Tools’ group on the ‘Data’ tab 
(see Figure 37). 
 

Select ‘Continue with the current selection’ in the Remove 
Duplicates Warning’ dialog box. Click ‘Remove Duplicates…’ 
(see Figure 38). 

Figure 35 

Figure 36 

Figure 37 

Figure 38 
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In the ‘Remove Duplicates’ dialog box, leave all the settings as they are and 
click ‘OK’ (see Figure 39 above). 
 

 
Excel displays a message 
showing that 332 unique values 
were found (see Figure 40). 
 
Clear all filters before 
proceeding. 
 

 
 

B6 Which age group (in years) has the smallest number of female athletes taking part 

in field events? 
13 

Method 1: Filtering 

Set filters on the following columns  

• Gender → Female 

• Event Type → Field 
 
Click on the filter drop-down for the ‘Age’ column. There are athletes in six age 
groups (see Figure 41). Click next to ‘(Select All)’ to deselect all the filters. Now 
select each age group one at a time and note the number of athletes returned in 
each case. 
 
The age group of 13 will have the smallest number of athletes. 
 
Method 2: COUNTIFS function 

If you click on the drop-down for the ‘Age Group’ column, you will see that there are six age groups from 
13 to 17. In an empty column to the right of the Athletes data, type the six age groups in a column one 
below the other. Next to the first age group (12), type in the following function: 
 
=COUNTIFS($F$2:$F$1337,Q2,$D$2:$D$1337,"Female",$I$2:$I$1337,"Field") 
 
As this function is going to AutoFilled to five more cells, absolute cell references 
have been used for each criteria range. Cell Q2 is where the age group 12 is 
stored. AutoFill this function down to the last age group (17) (see Figure 42). 
 
The age group with the smallest number of athletes is 13 (see Figure 42). This 
can easily be determined by inspection. 
 
 
 
 
 
 
Method 3: Subtotal 

Apply the following filters:  

• Gender → Female 

• Event Type → Field 
 
Copy the filtered data (with the column headings) to adjacent columns in a new worksheet:  

• Gender 

• Age Group 

Figure 42 

Figure 39 

Figure 40 

Figure 41 
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Working in the new worksheet, click anywhere in the filtered data and sort the ‘Age Group’ column from 
‘Smallest to Largest’ (ascending order).  
 
Click any cell in the data and click on ‘Subtotal’ which is in the ‘Outline’ group 
on the ‘Data’ tab (see Figure 43). 
 
 
 
 
 
 
 
 

The Subtotal dialog box will appear (see Figure 44).  
 

• Under ‘At each change in:’ select ‘Age Group’.  

• Under ‘Use function’ choose ‘Count’. 

• Under ‘Add subtotal to:’ select ‘Gender’ 
 
Leave the other selections as they are. Click on OK to apply the 
Subtotals.  
 
At the top left of the spreadsheet three numbers will 
appear (see Figure  45). This indicates the different 
grouping levels. Click on the ‘2’ which will show the 
subtotals for each age group. 
 
 
 
 
 

 
Figure 46 below shows the result of clicking the 2nd grouping level. It 
can easily be seen by inspection that the age group with the fewest 
athletes is 13. 
 
Clear any filters before proceeding. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Figure 43 

Figure 44 Figure 45 

Figure 46 
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Method 3: PivotTable 

Create a PivotTable as described in Method 3 of question B3. If you already 
created a PivotTable, you can simply modify it rather than creating a 
completely new PivotTable. 
 
Drag the ‘Event Type’ field to ‘Filters’, the ‘Age Group’ field to ‘Columns’, the 
‘Gender’ field to ‘Rows’ and the ‘Index’ field to ‘Values’ (see Figure 47). Note 
that the fields for ‘Columns’ and ‘Rows’ can be swapped around. 
 
The PivotTable shown in 
Figure 48 is created. 
 
 
 
 
 
 
 
 
 
 

 
Click on the drop-down arrow next to ‘(All)’ and select the ‘Field’ event type. The PivotTable now changes 
as shown in Figure 49.  
 

It can be seen by inspection that the age group 13 has the 
smallest number of female athletes. 
 
 

B7 How many unique athletes are there in the spreadsheet?  

(Note. Some athletes are entered in more than one event and so must only be 

counted once.) 

1083 

The key to answering this question is to find a way to count the number of athletes whose Index ends with 
‘1’. Every athlete has entered at least one event so each athlete will have an index which ends with ‘1’. 
 
Method 1: COUNTIF function 

Enter the following function in an empty cell to the right of the athlete data: 
 
=COUNTIF(A2:A1337,"*1") 
 
The function returns a value of 1083. 
 
Method 2: Remove duplicates 

Make sure that no filters are applied to the athlete data. 
 
Copy all the data in the ‘Index’ column (column A) and paste it into an empty column on a new worksheet. 
In the adjacent column, type in the function =LEFT(A1,6). This function extract the athletes unique number 
from the Index. AutoFill this function to the end of the data. 
 

Figure 47 

Figure 48 

Figure 49 
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Select the second column (without the ‘-1’ etc) and remove 
duplicates. This was described in detail in Method 3 of 
Question B5. A message box will appear at the end of the 
process showing that 1083 unique values were found (see 
Figure 50). 
 
 
 

 
Method 3: RIGHT Function and filtering 

Work in an empty column immediately to the right of the athlete data. Do not leave an open 
column between the new column and the existing data because AutoFill will not be able to 
determine how many rows are needed. 
 
In the new column type a heading such as ‘Index#”. In row 2 below the heading type in the 
function =RIGHT(O2,1). AutoFill this function to row 1337. The function extracts only the 
number showing the number of events the athlete has entered (see Figure 51). 
 
 
 
 
 
 

 
Make sure that filtering can be applied to this column by turning filtering off 
and then on again. Filter the data in the ‘Index#’ column to show only ‘1’. In 
the status bar you will see that 1083 records were found (see Figure 52). 
 

  

Figure 50 

Figure 52 

Figure 51 
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B8 A well-known English nursery rhyme goes as follows "Monday's child is fair of face, 

Tuesday's child is full of grace … Saturday's child works hard for their living". 

Successful athletes need to work hard to achieve good results and so must be 

Saturday's children. How many of the athletes were born on a Saturday?  

149 

This question can be solved using the WEEKDAY function. This function takes a date as argument and 
returns a number from 1 to 7 indicating the day of the week. The default setting for the function is that 1 is 
Sunday, 2 is Monday, etc with 7 being Saturday. See the website https://tinyurl.com/uepkx2j for more 
information about this function. 
 
WEEKDAY function 

In an empty column to the right of the athlete data type in the heading ‘Birth Day’ in row 1. 
In row 2 enter the function =WEEKDAY(E2). AutoFill this function to row 1337 (see 
Figure 53). 
 
Apply filtering as follows: 

• Index → Ends with 1 (to ensure that an athlete is not counted twice) 

• Birth Day → 7 (which will return athletes born on Saturday) 
 
On the Status Bar it can be seen that 149 records were found 
(see Figure 54). 
 
A VLOOKUP function could be used to convert the numbers to 
actual days but that is not necessary to answer this question. 

 

  

Figure 53 

Figure 54 

https://tinyurl.com/uepkx2j
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C: DATABASE 

The database Athletics Competition R1 2020.accdb contains information on athletes that registered to 

compete in the 2020 national athletics championships. The database comprises three tables, viz. 

tblAthletes, tblEvents and tblResults. The description of each field in the database is given in each table. 

Use the data in the Athletics Competition R1 2020 database to answer the following questions. 

Before answering questions in this section you should open each of the tables in Design View and read the 

descriptions of each field. 

Regional settings should be set correctly. The country or region 

should be South Africa and the Regional format set to English 

(South Africa). 

Access is fussy about dates being entered correctly. Short dates 

for the South African region should always be entered as 

yyyy/mm/dd. 

C1 How many of the athletes listed in the database were born in 2006? 324 

The dates of birth of the athletes are stored in tblAthletes.  
 
Method 1: Filtering 

Filtering is enabled by default in Access tables and 
queries in ‘Datasheet View’. Click the drop-down arrow 
next to the ‘DOB’ field. Click on ‘Date Filters’ to exand 
the menu and select ‘Between…’ (see Figure 55). 
 
In the ‘Between Dates’ 
dialog box type in 
2006/01/01 next to 
‘Oldest:’ and 2006/12/31 
next to ‘Newest:’ (see 
Figure 56). Click OK to 
apply the filter. 

 
At the bottom of the table it can be seen that 324 records were found (see Figure 57) 

 
In the ‘Sort & Filter’ group on the ‘Home’ tab, click the drop-down arrow next 
to ‘Advanced’. Click on ‘Clear All Filters’ before 
carrying on with the next question (see Figure 
58). 
 

 
 
 
 
 
 
 

Figure 55 

Figure 56 

Figure 57 

Figure 58 
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Method 2: Select query 

In the ‘Queries’ group on the ‘Create’ tab, click on 
‘Query Design’ (see Figure 59). In the ‘Show Table’ 
dialog box select tblAthletes, click ‘Add’ to add the 
table to the query and then click ‘Close’ (see Figure 
60). 
 
 
 

The query will now open in ‘Design View’ and the ‘Query By Design’ grid 
will appear (see Figure 61). 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Add the ‘DOB’ field to the grid. In the ‘Criteria:’ row of 
the grid type in ‘Between #2006/01/01# And 
#2006/12/31# (see Figures 62 and 63). For Access 
users who struggle with the small text size, the ‘Zoom’ 
box can be enabled by clicking in the ‘Criteria:’ row 
and pressing <Shift><F2>. The font type and size can 
be adjusted by clicking on the ‘Font…’ button. 

 
In the ‘Results’ group of 
the ‘Query Tools Design’ tab, either click the ‘Run’ button or select 
‘Datasheet View’ by clicking the drop-down arrown below ‘View’ and clicking 
on ‘Datasheet View’. 
 
 

At the bottom of the query output it can once again be seen that 324 records were found (see Figure 57). 

  

Figure 59 

Figure 60 

Figure 61 

Figure 62 

Figure 63 
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C2 How many athletes have surnames that end in “th” 14 

Athlete surnames are stored in tblAthletes. 
 
Method 1: Filtering 

Apply filtering to the ‘Surname’ field of tblAthletes. Select 
‘Text Filters’ and choose ‘Ends With…’ (see Figure 64). 
In the’Custom Filter’ 
dialog box type in ‘th’ 
and click OK to apply 
the filter (see 
Figure 65). 
 
14 records are found. 
 
Clear all filtering before proceeding to the next question. 
 

Method 2: Select query 

Create a new query in Design View. Add tblAthletes to the 
query grid. Add the ‘Surname’ field to the ‘Field:’ row of the 
grid. In the ‘Criteria:’ row type in ‘Like “*th”’ Note the use of 
the wildcard character ‘*’ to extract surnames which end 
with ‘th’ (see Figure 66). 
 

Run the query. See Figure 67 for the 
output of the query. Fourteen (14) 
surnames are found. 
 
 
 

C3 How many different track events in each category can females enter? 21 

This data needed to answer this question can be found in tblEvents. 
 
Method 1: Filtering 

Open tblEvents in Design View. 
 

The ‘EventCode’ field is a code which shows the age group, gender 
and event name for each event. The second letter is either ‘F’ for 
Female or ‘M’ for male. Apply a text filter to the ‘Event Code’ fields 
that contains the letter ‘F’ (see Figure 68). Filter the ‘EventType’ 
field to display only ‘Track’ events. 
 
 

 

Figure 64 

Figure 65 

Figure 66 

Figure 67 

Figure 68 
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21 records matching these criteria are found. See Figure 69 for 
the first few rows of the output. 
 
Clear all filters before proceeding to the next question. 
 
Method 2: Select query 

Create a new query in Design View. Add tblEvents to the query grid. Add at least the ‘EventCode’ and 
‘EventType’ fields to the grid. More fields can be added if you wish. 
 

For the ‘EventCode’ field add the criterion Like “*F*”. This will 
extract all the events for female athletes. Add the criterion 
“Track” to the ‘EventType’ field (see Figure 70). 
 
Run the query. 21 records are found. 
 
 
 

 
Method 3: Totals query 

The number of events for female athletes can also be counted by creating a query which uses data in 
tblAthletes (gender and category) and tblEvents (event name and event type). The database used for 
the Olympiad is an example of a relational database. Primary keys are created in all three tables which 
are used to link the tables together ensuring that information is not duplicated across multiple tables. 
 
The relationships in the database are shown below (see Figure 71). 
 

tblAthletes is linked to tblEvents using 
tblResults. The relationship between 
tblAthletes and tblEvents is known as 
a many-to-many relationship. 
 
If a query involves tblAthletes and 
tblEvents, tblResults must also be 
added to the query grid to link the tables 
together. It is possible to create queries 
using more than one table without 
having an in-depth understanding of 
relational databases. 
 

 
Create a new query in Design View. Add all three tables to the query grid. Add the following fields to the 
grid 

• EventName from tblEvents 

• Category from tblAthletes 

• EventType from tblEvents 

• Gender from tblAthletes 
 
Add the criterion “Track” to the ‘EventType’ field and “Female” to the ‘Gender’ field. If you run the query 
you will find that 513 records are found which cannot possibly be correct. That number is actually the 
number of athletes.  
 

Figure 70 

Figure 71 

Figure 69 
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In the ‘Show/Hide’ group of the ‘Query Tools Design’ tab click on 
‘Totals’ (see Figure 72). An additional ‘Total:’ row is added to the 
query grid. ‘Group By’ is added to the ‘EventName’ and ‘Category’ 
fields. ‘Where’ is added to those fields that have criteria 
(‘EventType and ‘Gender’). The ‘Where’ fields can no longer be 
shown as the event names and categories are grouped together. 
Access removes the tick from the ‘Show:’ row (see Figure 73). 
 
 

 
The query groups the records in the two 
tables first by event name and then by 
category.  
 

 
 
 
 
 
See Figure 74 for the output of the query. 21 records are found. 
 

C4 How many athletes across all age groups and genders did not qualify for 

round 2 of the 100 m races? 
110 

The data needed to answer this question is stored in tblEvents (‘EventName’) and tblResults (‘Round2’). 
 
Method 1: Select query 

Create a new query in Design View. Add tblEvents and 
tblResults to the query grid. Add the fields ‘EventName’ from 
tblEvents and’Round2’ from tblResults to the query grid. Add the 
criterion “DNQ” to the ‘Round2’ field and “100 m” (or Like “100 m”) 
to the ‘EventName’ field (see Figure 75). 
 
Run the query. 110 results are returned. 
 
Instead of adding criteria to the query grid, you can also run the 
query without criteria and filter the ‘Round2’ field to display ‘DNQ’ 
and the ‘EventName’ field to display ‘100 m’. Using a query with 
criteria has the advantage that the query can be saved and run 
again at any time. 
 
 
 

Figure 72 

Figure 73 

Figure 74 

Figure 75 
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Method 2: Crosstab query 

A Crosstab query in Access is similar to a PivotTable in Excel. Crosstab queries are based on either a 
table or another query. If the data needed is in two tables it is necessary to create a select query first on 
which to base the Crosstab query. 
 
Create a select query based on tblEvents and tblResults. Add the fields ‘AthleteID’ and ‘Round2’ from 
tblResults and ‘EventName’ from tblEvents to the query grid. Do not add any criteria. Save the query. 
 
In the ‘Queries’ group on the ‘Create’ tab click ‘Query Wizard’ (see Figure 76).  
 
 

The ‘New Query’ dialog box will open. Select 
‘Crosstab Query Wizard’ and click ‘OK’. The 
wizard will guide you step by step through the process of 
creating a Crosstab query (see Figure 77). 
 
 
 
 
 
 
 
 
 
 
 

 
In the first dialog box of the ‘Crosstab Query Wizard’ click on 
the ‘Queries’ option button. In the list of queries click on the 
query on which you are basing your Crosstab query (see 
Figure 78). 
 
Click ‘Next >’ to proceed to the next step. 
 
 
 
 
 
 
 
 

 
In the next dialog box select the field ‘Round2’ to use as row 
headings (see Figure 79). You could also select 
‘EventName’. 
 
Click ‘Next >’ to proceed to the next step. 
 
 
 
 
 
 
 
 
 
 

Figure 76 

Figure 77 

Figure 78 

Figure 79 
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In the next dialog box click on the ‘EventName’ field to be used 
as column headings (see Figure 80). 
 
Click ‘Next >’ to proceed to the next step. 
 
 
 
 
 
 
 
 
 
 

 
In the next step the ‘AthleteID’ field is left. Select the ‘Count’ 
function (see Figure 81). The Count function is used because 
the question ask “How many athletes…”. 
 
 
 
 
 
 
 
 
 
 
 

 
In the final step of the wizard leave the default setting at ‘View 
the query’ and click ‘Finish’ (see Figure 82). 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 83 shows part of the results 
returned by the query. Access also 
creates a name for the query which 
you can use when saving the query. 
 
At the interection of the DNQ row 
and 100 m row the number 110 is 
found. 
 

Figure 80 

Figure 81 

Figure 82 

Figure 83 
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C5 What is the average age of all the athletes in the youth category? Give 

your answer correct to 2 decimal places. 
15.11 

The athletes’ age and category are both stored in tblAthletes.  
 
Method 1: Filtering and summary function 

Open tblAthletes in Datasheet View. 
 

Filter the ‘Category’ field to display only the ‘Youth’ category. 
In the ‘Records’ group on the ‘Home’ tab click the ‘Totals’ 
button (see Figure 84). 
 
This adds an additional row 
called ‘Total’ at the bottom 
of the window in which the 
table is displayed (see 
Figure 85). 
 

At the bottom of the column containing the ‘Age’ field data click in the new Total row. 
Click the drop-down arrow to display a list of possible summary functions. Select 
‘Average’. The value 15.10852… is displayed (see Figure 86). 
 
The question requires the answer correct to two decimal places which give a result of 
15.11 (or 15,11). 
 
Clear all filters and click on the ‘Totals’ button to remove the Total row before proceeding 
to the next question. 
 
Method 2: Totals query 

Create a new query in Design View based on tblAthletes. Add the 
‘Age’ and ‘Category’ fields to the query grid. Now click on the 
‘Totals’ icon in the ‘Show/Hide’ group of the ‘Create’ tab (see 
Figure 88). Add the criterion 
“Youth” to the ‘Category’ field. 
 
In the ‘Total:’ row change ‘Group 
By’ for the ‘Age’ field to ‘Avg’ and 
change the ‘Category’ field to 
‘Where’ (see Figure 87). 

 
Run the query. 
 

Figure 89 show the output of the query. 
Round off the value displayed to two 
decimal places giving an answer of 
15.11. 
 
 
 

  

Figure 84 
Figure 85 

Figure 86 

Figure 88 

Figure 87 

Figure 89 
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C6 Assuming that the name-surname combinations are unique, what is the 

most common surname amongst the female athletes? 
Smith 

The data needed to answer this question is stored in the ‘Surname’ and ‘Gender’ fields of tblAthletes. 
 
Method 1: Totals query 

Create a new query in Design View. Add tblAthletes to the query grid. Add the ‘Surname’ field twice to 
the query grid. To count surnames with a totals query it is necessary to have one instance of the Surname 
field to group by and another to count number of occurences of each surname. Also add the ‘Gender’ field 
to the query grid. 
 

Click on the ‘Totals’ icon to add a ‘Total:’ row to the query. 
Leave the first instance of ‘Surname’ as ‘Group By.’ Change 
the second instance of ‘Surname’ to ‘Count’. Change the 
‘Gender’ field to ‘Where’ and add the criterion “Female”. In 
order for the most common surname to appear at the top of 
the output add ‘Descending’ order sorting to the second 
‘Surname’ field (see Figure 90). 
 
Run the query. The surname 
‘Smith’ is the most common, 
appearing 7 times in the database 
(see Figure 91). 
 
 
 

 
 
 
Method 2: Crosstab query 

Creating a Crosstab query was described in detail in Method 2 of question C4. Refer back to that question 
if necessary. 
 
Use the ‘Query Wizard’ to create a new Crosstab query. 

• Base the query on tblAthletes 

• Use the ‘Surname’ field for row headings 

• Use the ‘Gender’ field for column headings 

• Apply the Count function to the ‘AthleteID’ field. 
 

View the query. Figure 92 shows the first few rows of the output. 
In order to see the most common female surname, either sort the 
‘Female’ column in descending order (largest to smallest) or filter 
the ‘Female’ column to show only the surname which appears 7 
times. 
 
It can be seen 
that the most 
common female 
surname is Smith (see Figure 93). 

 

  

Figure 90 

Figure 91 

Figure 92 

Figure 93 
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C7 What is the surname of the athlete who achieved the fastest time in the 

100 m for 14 year-old males? 
Martin 

All three tables are needed to answer this question. The surname, age and gender are stored in 
tblAthletes, the time for the race in tblResults and the race name (100 m) in tblEvents. The athletes’ 
times or distances are stored in the ‘Round1’ field. 
 
Select query 

Create a new query in Design View. Add tblAthletes, tblEvents and tblResults to the query grid. 
 
Add the following fields to the query grid: 

• Surname, Age and Gender → from tblAthletes 

• EventName → from tblEvents 

• Round1 → from tblResults 
Add criteria as follows: 

• Age → 14 

• Gender → “Male” or Like “Male” 

• EventName → “100 m” or Like “100 m” 
Add sorting as follows: 

• Round1 → Ascending (smallest to largest). For timed events smaller (faster) times are better. 
 
Figure 94 shows what the query grid 
should look like before running the 
query.  
 
Note that the order of the fields on the 
grid is not important. 
 
 
 
 
 
 
 
 

 
The athlete with the fastest time (12,18 
seconds) has the surname Martin (see 
Figure 95). 

  

Figure 94 

Figure 95 
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C8 The 7th digit of the SA ID number indicates female (0 to 4) or male (5 to 9). 

There are some errors in the classification of the gender of 6 of the 

athletes in the database as one gender is given in the gender field while 

the other gender is included in the ID number. Assuming that the ID 

number is correct, for how many female athletes is the gender 

classification incorrect? 

2 

The data needed to answer this question, ID number 
and gender, is stored in tblAthletes. 
 
Select query with a calculated field 

Create a new query in Design View. Add tblAthletes to 
the query grid. 
 
Add the ‘Gender’ and ‘SAID’ fields to the query grid (see 
Figure 96). 
 
 
 
 
 
 

Add a calculated field (called ‘IDGender’ in the example shown). 
Use the ‘Mid’ function to extract the 7th digit of the ID number 
(see Figure 97). Note that the Excel text functions LEFT, RIGHT 
and MID are also available in Access. 
 
There will be some athletes whose ID number (between 0 and 
4) indicates that they are female but their gender is recorded 
incorrectly as 

male. In order to find how many such athletes there are add 
criteria to the query grid as follows (see Figure 98): 

• Gender → “Male” 

• IDGender → Between 0 And 4 
 
Run the query. The output of the query (see Figure 99 
below) shows that there are two female athletes with incorrect genders. 
 

 
 
 

 

Figure 96 

Figure 97 

Figure 98 

Figure 99 


